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Overview 

This tutorial is optimized for Echoview 15 and provides an introduction to bottom classification.  

This tutorial is not intended as a comprehensive user manual.  

Further information on Echoview tools and topics can be found in the latest version of the Echoview help file. 
This can be viewed online and is installed with Echoview. Press F1 when using Echoview to open the help file 
and read context-sensitive information. 

Throughout this tutorial further reading is referred to the Echoview help file or other Echoview learning 
materials: https://www.echoview.com/support 

Prerequisites 

This tutorial assumes you have Echoview installed, and the following skills and knowledge: 

• Familiarity with the basic operation of Echoview. We strongly recommend that you complete the "Getting 
Started with Echoview" tutorial before beginning this tutorial.  

• Familiarity with a supported Microsoft Windows™ operating system. For more information refer to the 
Echoview Help file page: Computer requirements.  

• A basic understanding of echosounding techniques and hydroacoustic surveying. For more information, 
see texts such as Fisheries Acoustics (Simmonds and MacLennan, 2005, Blackwell Science, Oxford.). 

Echoview modules 

This tutorial requires a license with the Habitat Classification module. 

Use of the Background noise removal operator requires the Advanced Operators module. 

If you do not yet have access to an Echoview license with these modules, please contact info@echoview.com 
to request an evaluation license. Solution files are also included in the tutorial package to allow you to see the 
results of module-protected capabilities. 

Contacting Echoview  

For assistance with this tutorial please contact support@echoview.com. 

Set up 

We recommend extracting or copying the tutorial files to C:\Echoview Software\Tutorials\. If the files 

are not in this folder, use Windows Explorer to search for them. If they are not loaded on your machine, 
download and reinstall the tutorial from www.echoview.com or from the Echoview USB drive. 

Troubleshooting 

If you receive a message saying that the version of Echoview you are running cannot read the file you have 
opened, you may be running an old version of Echoview. You can download the latest version of Echoview 
from www.echoview.com.  

Acknowledgements 
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Topic 1: Overview of Bottom Classification 

Acoustic bottom classification 

The successful management of aquatic ecosystems requires an understanding of the interactions between the 
life forms that inhabit its regions, and the structure and processes of the constituent physical regions. 

The collection of hydroacoustic data can provide information from both areas. Echo returns in the water 
column determine biomass, and the use of bottom echo returns differentiate changes in the bottom. 

Acoustic bottom classification is the process and partitioning of acoustic bottom returns into discrete classes 
that may represent bottom types, such as rock or sand. The classification becomes powerful when calibrated 
hydroacoustic data and ground-truth data are used together. Calibration offers qualitative and reproducible 
data, while ground-truth data offers a mapping for the classes. As a result, acoustic bottom classification is 
more cost-effective than the collection of extensive grab samples or comprehensive visual verification1. 

 

 

Figure 1. Scott Lake bottom classification displayed through various Echoview windows. 

 

Figure 1 shows Echoview after a complete bottom classification of Scott Lake, Canada. The figure includes a 
bottom classification graph, bottom points cruise track, bottom points table, Video window, and a Sv echogram 
with a bottom classification integram. 

Echoview bottom classification 

Echoview bottom classification is suitable for single, split and dual beam Sv data which may contain only a 
first-bottom echo trace, or Sv data containing both a first-bottom echo trace and a second-bottom echo trace. 

Bottom_roughness_normalized and other bottom features are determined from the first-bottom echo trace. 
Bottom_hardness_normalized and Second_bottom_length_normalized are determined from the second-
bottom echo trace. Bottom classification using an echogram containing only a first-bottom echo trace is 
possible but will be limited due to having fewer bottom features calculated, resulting in the clustering algorithm 
having fewer features to process.  

Echoview’s bottom classification algorithms are based on bottom classification techniques published in the 
research literature2.  
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The main aspects of the algorithms include: 

• specifiable depth normalization 

• bottom feature Z-score used with automatic Principal Component Analysis (five dimension) or manual 
specification with specified dimensions 

• automatically or manually specified k-Means based clustering, with k-Means++ cluster initialization and 
two clustering algorithms. 

For further information, refer to the Echoview Help file pages About bottom classification and Bottom 
classification algorithms. 

  

https://support.echoview.com/WebHelp/How_To/Classify_Bottoms/About_bottom_classification.htm?rhhlterm=bottom%20classification%20classifications&rhsearch=bottom%20classification
https://support.echoview.com/WebHelp/Reference/Algorithms/Bottom_Classifcation/Bottom_classification_algorithms.htm?rhhlterm=bottom%20classification%20classifications&rhsearch=about%20bottom%20classification
https://support.echoview.com/WebHelp/Reference/Algorithms/Bottom_Classifcation/Bottom_classification_algorithms.htm?rhhlterm=bottom%20classification%20classifications&rhsearch=about%20bottom%20classification
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Topic 2: Introducing a Bottom Classification Survey and Dataflow 

Data files 

This tutorial will use seven Simrad ES70 data files logged during an extensive hydroacoustic survey of Scott 
Lake, Canada (for more information see the Acknowledgements). The complete survey consisting of 70,000 
pings was logged over a three-hour period, and traversed Scott Lake. From the full dataset, Echoview can 
determine 14 classes of bottom type that correlate well to ground truth provided by substrate grabs and video 
data as seen in Figure 2. 

 

 

Figure 2. Cruise track showing bottom classification results of the entire survey. The 14 class colors and class 
names reflect the characterization of substrates from substrate sampling. The files used in this tutorial cover the 

area inside the black rectangle. 

A factor that can affect the quality of a bottom classification is the number of pings used. Generally, more 
pings result in better (more stable) statistics for class allocation, as the sample mean may better approximate 
the population mean3.  

The data files used in the following steps of this tutorial will cover a 20-minute, 8000-ping subset from the 
survey. When using a feature extraction interval of 10 pings, the classification algorithms will work with 800 
intervals.  

To achieve a good correlation with bottom classification of the large survey, this tutorial will create nine classes 
within the data. The tutorial solution EV file class colors have been edited to match the class colors from the 
large survey classification. While the correlation between bottom classifications from the 70,000-ping and 
8000-ping datasets are close, they are not a match.  
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Dataflow 

 

 

Figure 3. The numbered dataflow stages show the steps required for a simple bottom classification. The table following 
provides information about each stage. 

 

Stage Aim Echoview features or operators used 

1a Prepare Sv data Select a variable (frequency) 

1b Remove background noise Create a Background noise removal variable 

2a Identify the bottom Detect a bottom line using the Best bottom candidate 
line-pick algorithm 

Edit the line pick (quality control) 

2b Configure settings for bottom 
classification, and undertake a 
bottom classification  

Configure the variables bottom classification settings and 
configure the bottom-classification algorithm 

On the Echogram menu, click Classify Bottom 

3 Analyze bottom classification 
results, and reclassify the bottom 

Display bottom classification results as an integram, as a 
graph, as a cruise track, and as a table  

Run a new bottom classification 

Export results 
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Topic 3: Getting Started  

Preparing data 

The general preparation of Sv echogram data prior to bottom classification preparation includes verifying and 
using calibration settings; identifying and dealing with unsuitable echogram data such as intermittent noise, 
bad samples, and unwanted data from the water column. For further information on these topics refer to the 
Getting Started tutorial and Help file topics on calibration and ECS files, creating regions and region types 

More specific bottom classification preparation includes the removal of background noise, line pick/editing and 
the specification of bottom classification settings. 

1. Start Echoview. 

2. On the File menu, click New. The Dataflow window and Filesets window are displayed. 

3. Click Add in the Filesets window.  

4. Browse to the location of these tutorial data files and select all 7 files: 

• D20090924-T152516.raw  

• D20090924-T152744.raw  

• D20090924-T153013.raw   

• D20090924-T153243.raw  

• D20090924-T153513.raw  

• D20090924-T153742.raw  

• D20090924-T154012.raw  

5. Click Open. The selected data files are displayed in the Data files section of the Filesets window. The 
data files contain 23 raw variables that are listed in the Raw variables section of the Filesets window. 

6. In the Raw variables section of the Filesets window, click Sv raw pings T4. 

7. Click . The echogram of Sv raw pings T4 variable is displayed. 

8. Right-click on the echogram, select Variable Properties (F8), then click Echogram Display. Select 
Manually set the display limits and enter 30.00 as the Lower display limit (m). Click OK. 

The Sv raw pings T4 variable, which has a frequency of 710 kHz, shows a clearly visible first-bottom echo 
trace and second-bottom echo trace. Both these traits make this data ideal for use in bottom classification. 

 
Figure 4. Sv raw pings T4 echogram with first and second bottom echo. 
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Removing background noise 

Bottom classification uses the Bottom echo threshold at 1 m setting on the Analysis page of the Variable 
Properties dialog box to separate samples and noise. Two methods are described for this estimate.  

One method uses the Background Noise Removal virtual variable that is licensed by the Advanced Operators 
module. The value for Bottom echo threshold at 1 m on the Background noise removal variable includes all 
valid samples and excludes samples close to the noise and is relatively simple to specify. 

The other method doesn’t require a licensed Advanced Operators module. An approximate value is estimated 
from the raw variable ping graph and is then applied to the raw Sv variable. 

Notes 

• The bottom classification algorithm requires that data samples of the bottom echo traces describe a 
complete echo. Missing data samples or an incomplete echo can result in the output of no-data bottom 
points during a classification.  

• For further information refer to the Help file topics: About the integram and Using the integram. 

Ping Graph method Background noise removal method 

The Background Noise Removal operator estimates the background noise level and subtracts it from the value 
of each sample and also allows a simple way to set the Bottom echo threshold at 1 m before running a 
bottom classification.  

9. On the View menu click Dataflow. 

10. Within the Dataflow window, on the Shortcut (right-click) menu, point to New, then click Variable…. The 
New Variable dialog box is displayed. 

11. Select the Background noise removal operator. Click OK. The Variable Properties dialog box will 
automatically open at the Operands page. 

12. In the Operand 1 list, select Sv raw pings T4.  

13. View the Background Noise Removal page of the Variable Properties dialog box. Take a moment to 
review the available settings. The Maximum noise (dB) box has the default value of -125 dB. In this case, 
the default provides a good balance between noise removal and the minimization of no-data bottom points 
in a bottom classification. The settings can be adjusted to suit other data sets, use F1 to display 
information from the Help file. 

14. Click OK. 

15. On the Dataflow window select Background noise removal 1. 

16. On the Shortcut (right-click) menu, click Echogram. The echogram of the Background noise removal 1 
variable is displayed. 

17. Point at a ping on the Background noise removal 1 echogram. On the Shortcut (right-click) menu, click 
Graph Ping. As a diagnostic tool, you can use a ping graph (with keyboard shortcuts F and R) to check 
the data samples in the first-bottom echo trace and second-bottom echo trace. For more information refer 
to the Echoview help file page Configuring a bottom classification. 

 

Identify the start of the bottom 

Set up the line-pick algorithm. 

18. On the View menu click EV File Properties (or press F6) to open the EV File Properties dialog box. 

19. Click on Line and Surfaces and then view the Single beam tab. 

In the Line picking algorithm list, select Best bottom candidate and enter the following values: 

Start depth (m): 0.50 

Stop depth (m): 30.00 

Minimum Sv for good pick (dB): -70.00 

https://support.echoview.com/WebHelp/How_To/Work_With_The_Integram/About_the_integram.htm?rhhlterm=integram%20integrams&rhsearch=about%20integrams
https://support.echoview.com/WebHelp/How_To/Work_With_The_Integram/Using_the_integram.htm?rhhlterm=using%20useful%20uses%20integram&rhsearch=using%20integrams
https://support.echoview.com/WebHelp/How_To/Classify_Bottoms/Configuring_a_bottom_classification.htm?rhhlterm=configuring%20configuration%20bottom%20classification&rhsearch=Configuring%20a%20bottom%20classification
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Select Use Backstep 

Discrimination level (dB): -60.00 

Backstep range (m): -0.05 

Peak threshold (dB): -55.00 

Click OK. 

Pick the bottom line 

20. Display the Background noise removal 1 echogram. 

21. On the toolbar, click on the▼icon on the Line and Surface  button to open the menu, and 
then click New Editable Line.  

Into the Create a new line box, type: Bottom line.  

Select Pick from current variable.  

Select Span gaps.  

Click OK. 

A line will be picked from the echogram data. The line will be visible on the echogram and as an object on the 
Dataflow window (Figure 5). 

 
Figure 5. Background noise removal 1 echogram with Bottom line in green. 

 

The samples immediately below the Bottom line will represent the first-bottom echo trace. Samples detected 
at twice the bottom line depth will represent a second-bottom echo trace. Be aware that any samples from the 
water column that occur below the bottom line will distort bottom echo trace calculations and in turn the 
bottom-classification results. For this reason, it is good practice to inspect line picks and manually line edit 
unsatisfactory sections. In this tutorial, the line pick is largely satisfactory however, there is a section around 
ping 6260 that requires a manual line edit with the Line edit tool. The Line tool is discussed in the Getting 
Started tutorial. 
 

Settings for bottom classification 

View the Dataflow window . 

22. Select the Bottom line variable. 

23. Display a line graph of Bottom line. Double-click the dataflow object, or on the Shortcut (right-click) 
menu, click Graph (Figure 6). Estimate the average depth of the line: approximately 3.5 meters (this 
number does not need to be precise). 
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Figure 6. Line graph for Bottom line shows an estimated average depth of 3.5 meters. 

24. Display the Background noise removal 1 echogram. 

25. On the Shortcut (right-click) menu, click Variable Properties (or press F8).  

26. View the Analysis page of the Variable Properties dialog box.  

Under Bottom Settings, in the Bottom line list, select Bottom line.  

Into the Bottom echo threshold at 1m (dB) box, type: -500.  

Into the Depth normalization reference depth (m) box, type: 3.5.  

Click OK. 

The Background noise removal operator sets identified noise samples to -999 dB. Setting Bottom echo 
threshold at 1m (dB) to -500 ensures that bottom classification will include all valid samples in the echo trace 
but excludes samples that are close to the noise. 
  



 

Echoview Tutorial: Introduction to Bottom Classification Page 12 of 18 

 

Topic 4: Initial Bottom Classification and Subsequent Tuning 

Automatic bottom classification  

Undertaking a bottom classification using various automatic settings is useful to get an initial understanding of 
the potential bottom classes of the echogram. 

View the EV File Properties dialog box (press F6). 

1. View the Bottom Classification page of the EV File Properties dialog box. 

Under Features to Extract, ensure all features are selected. 

Under Cluster Dimension Selection, ensure Automatic (Principal component analysis) is selected. 

Under Bottom Class Allocation, ensure Automatic detection is selected.  

In the Method list, ensure Calinski-Harabasz is selected.  

Into the Clustering iterations box, type: 30. 

Click OK. 

Display the Background noise removal 1 echogram. 

On the Echogram menu click Classify Bottom.  

The Classify Bottom dialog box is displayed. 

Into the Variable name box, type: Bottom classification (Automatic). 

Ensure Show bottom classes on integram is selected. 

Click Classify. 

When processing is complete, an object named Bottom classification (Automatic) will be available on the 
Dataflow window. The Bottom classification (Automatic) variable contains the bottom-classification results. 
Saving the EV file will save the variable and the bottom classification results. 

Note: If you do not have a licensed Habitat Classification module, or an Echoview evaluation license, please 
open the solution EV file found in the data file folder to view the classification results. 

2. Review the integram for the Background noise removal 1 echogram (Figure 7). As Show bottom 
classification on integram was selected on the Classify Bottom dialog box, the echogram displays the 
resulting bottom classification result class colors in the echogram integram area.  
 

Figure 7. Echogram with bottom classification result integram shown along the bottom. 
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Viewing bottom classification results as a cruise track 

3. On the Dataflow window select Bottom classification (Automatic). 

4. On the Shortcut (right-click) menu, click Cruise Track. The bottom classification results will be shown as 
a cruise track.  

Note: The use of automatic settings determines a set of classes based on the characteristics of the data set 
analyzed. The random initialization of clustering can lead to slight variations in the final number of classes.  

Viewing bottom classification results as a graph 

5. On the Dataflow window select Bottom classification (Automatic).  

6. On the Shortcut (right-click) menu, click Graph. A Bottom roughness normalized versus Bottom hardness 
normalized graph is displayed. 

7. On the Dataflow window, again select Bottom classification (Automatic). 

8. While holding Ctrl on the Shortcut (right-click) menu, click Graph. A second Bottom roughness 
normalized versus Bottom hardness normalized graph is displayed. 

9. Point at the second graph. On the Shortcut (right-click) menu, click Graph Properties.  

Select Override variable settings. 

In the X-Axis data list, select Bottom_roughness_normalized. 

In the Y-Axis data list, select Bottom_rise_time_normalized. 

Click OK. 

Review the Bottom classification result graphs docked side by side (Figure 8). The two graphs show a 
clustering of points and a clear separation of class. Graph axis features that result in separated point clusters 
may be useful when used as cluster dimensions when tuning the bottom classification settings while 
undertaking manual bottom classification. 

 
Figure 8. Side-by-side comparison of Bottom classification result graphs. 

Note: Any number of bottom classification graphs can be displayed, each with any feature-to-axis 
combination. You may need to plot a number of graphs to find features that may be useful as cluster 
dimensions.  
 

Manual bottom classification 

10. View the EV File Properties dialog box (press F6). 

11. View the Bottom Classification page. 
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Under Features to Extract, ensure all features are selected. 

Under Cluster Dimension Selection, select Manual. 

Click the Dimension Properties button.  

12. The Manual Dimensions dialog box is shown. 

Leave Bottom_roughness_normalized selected. 

Leave Bottom_hardness_normalized selected. 

Select Bottom_rise_time_normalized. 

Click OK. 

13. Under Bottom Class Allocation, select Manual. 

Into the Class count box, type: 9. 

In the Cluster measure list, ensure Calinski-Harabasz is selected.  

Into the Clustering iterations box, type: 30. 

Click OK. 

Information from the analysis of the complete survey and site sampling indicate that nine clusters with 30 
iterations are suitable for the data in this tutorial. 

14. Display the Background noise removal 1 echogram. 

15. On the Echogram menu click Classify Bottom. The Classify Bottom dialog box is displayed. 

Into the Variable name box, type: Bottom classification (Manual). 

Click Classify. 

When processing is complete an object named Bottom classification (Manual) will be available on the 
Dataflow window.  
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Topic 5: Viewing and Using Bottom-Classification Results 

Viewing manual bottom-classification results as a cruise track 

16. On the Dataflow window select Bottom classification (Manual). 

17. On the Shortcut (right-click) menu, click Cruise Track (Figure 9). 

 

Figure 9. Bottom classification displayed as a cruise track. 

Initial bottom classification result, class colors and class names are assigned automatically. The class colors 
and names can be manually edited after their creation. 
 

18. On the Dataflow window select Bottom classification (Manual). 

19. On the Shortcut (right-click) menu, click Variable Properties. 

20. View the Classes page of the Variable Properties dialog box. 

21. Under Bottom Classes select Bottom class 1. 

Into the Name box, type Renamed class. 

Click the color swatch. The Color dialog box is displayed. 

Select a color. 

Click OK. 
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On the Variable Properties dialog box, click OK. The class name will be updated in the cruise track 
window. The color of the class will be updated in the cruise track window and in graph windows. 

The colors of classes in Figure 9 have been manually edited to represent those of the colors assigned in the 
extensive hydroacoustic survey of Scott Lake (see Figure 2).  
 

Viewing bottom classification results as a table 

22. On the Dataflow window select Bottom classification (Manual). 

23. On the Shortcut (right-click) menu, click Table. Bottom classification results will be shown as a table 
(Figure 8). 

 

Figure 10. Bottom classification results table. 

24. Double-click a row of the table. Displayed echogram windows and cruise track windows will synchronize to 
the date and time of the row.  

When double-clicking on the bottom classification results within the cruise track window, table and echogram 
windows will synchronize. Synchronization is also useful when video data and/or substrate sampling data is 
available to correlate with the bottom classification result classes.  
 

Exporting bottom classification results 

Bottom classification results can be exported from the Dataflow window, from the table window and from the 
cruise track window.  

25. On the Dataflow window select Bottom classification (Manual). 

26. On the Shortcut (right-click) menu, click Export then Data Values…. 

27. Under Select range to export ensure All measurements is selected. 

28. Click Export. 

29. Into the File name box, type: Bottom_classification_results 

30. Click Save. 

Using the csv file format, calculated bottom features and bottom classification results can be further examined 
in third-party statistical packages. 

Note: If you do not have a licensed Habitat Classification module, or an Echoview evaluation license, please 
examine the provided file:  
Bottom_classification_results(solution).bottom.points.csv 

Select the File menu and click Close. Click Yes when prompted if you want to save changes to the EV file. 
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Further information 

Help file topic title Description 

About bottom classification Overview of bottom classification. 

Configuring a bottom classification 

 

Discussion of factors that affect bottom classification settings 
and bottom classification algorithms. 

Bottom classification analysis options Discussion of techniques for the examination of bottom 
classification results: auto-synchronization, video footage, 
reclassify with the same features but different cluster settings 
and exporting data. 

Bottom classification algorithms Discussion of algorithms and references. 

Bottom classification – practical notes Practical excerpts on bottom classification from reference 
papers. 

Habitat Classification module Overview of the functionality offered by the Habitat 
Classification module. Alongside bottom classification, the 

module enables the use of the Threshold offset line operator 
(used to detect the boundary of features like vegetation, 
transducer ring down, bubbles around the transducer, shadow 
zones or dead zones) and vegetation analysis export. 
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